
STEM Lesson n°1 

« Discover Robotics by Building Pedro! 

v1.0.1

PDF Tricks
(To make sure the PDF file that opens in your browser shows the most up-to-date version, 

add a version query to the URL, like this:
https://almtzr.github.io/PedroSTEM/stem_lessons//myfile.pdf?v=2)

1 / 19
Pedro STEM Lesson n°1                                                                                                                   https://pedrobot.com

https://pedrobot.com/


 Learning Objective🎯

This lesson introduces students to P.E.D.R.O the Programmable Educational Robot, fully 3D-
printed, open-source robot designed to make robotics learning fun and hands-on. By the end of this 
session, students will:

 Understand the basics of robotics and embedded systems
 Learn how 3D printing works and how robots are designed
 Assemble and control their own Pedro robot
 Upload code to Pedro using the Arduino IDE
 Identify and explain the main components of a robot

 Instructor Notes👨‍🏫

 Recommended age: 12 years and older
 Ideal for STEM clubs, classroom workshops, or science projects
 Students should have basic computer literacy
 Duration: ~2 hours

  Required Materials🧰

Item Quantity Description

Pedro Robot Full Kit 10 units One robot by student

Computer (Windows, Linux, or OS X) 1 or 2 units With Arduino IDE installed

 Final Activity🧩

At the end of the workshop:

 Students complete a 30-question quiz to review key concepts.
 Teachers can discuss real-world applications of robotics and 3D printing.

2 / 19
Pedro STEM Lesson n°1                                                                                                                   https://pedrobot.com

https://pedrobot.com/


Table of Contents
 Learning Objective🎯 ......................................................................................................................... 2
 Instructor Notes👨‍🏫 .............................................................................................................................. 2
 Required Materials🧰 .........................................................................................................................2
 Final Activity🧩 .................................................................................................................................. 2

1. Materials Check................................................................................................................................4
2. What Is 3D Printing?........................................................................................................................ 5
3. Design...............................................................................................................................................6

 3.1 The Pedro Anatomy..................................................................................................................6
 3.2 Planetary Gear System..............................................................................................................7
 3.3 What is a planetary gear system in robotics?............................................................................7
 3.4 Why use a planetary system on Pedro?....................................................................................7

4. The Pedro Board...............................................................................................................................8
 4.1 Main Features...........................................................................................................................8
 4.2 STEM Insight............................................................................................................................8
 4.3 Identify Each Element of the Pedro Board:..............................................................................9

5. Installing and Uploading Pedro Firmware.....................................................................................12
6. Assembling..................................................................................................................................... 13

Step 1: The Base............................................................................................................................ 13
Step 2: The Gripper........................................................................................................................14
Step 3: The Arm.............................................................................................................................15

7. Quiz (30 Questions)........................................................................................................................16

3 / 19
Pedro STEM Lesson n°1                                                                                                                   https://pedrobot.com

https://pedrobot.com/


1. Materials Check

Make sure you have all the parts before starting the assembly. 
Check all the parts by putting an  next to each part of Pedro robot.✅

 All Pedro 3D printed  parts✅
 Pedro Rev3 Electronic Board✅
 2 ball bearings ✅ 8x22x7 mm

 4 continuous rotation (✅ 360°) servomotors

 7.4V DC battery✅

 💡What You Should Know About   Pedro  

All the parts of Pedro are 3D printed. As you can see, there are no screws in the pieces that make up 
Pedro. Which makes Pedro a 100% 3D-printed robot.
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2. What Is 3D Printing?

3D printing is a technology that allows us to create solid objects by melting and layering plastic 
filament (PLA or ABS). Before printing a part, several important steps are needed:

1. Design (CAD):
The first step is to design the part using a CAD (Computer-Aided Design) software. This 
program lets us draw the object in three dimensions on a computer.

2. Export to STL:
Once the design is finished, it is converted into an STL file. This file describes the shape of 
your object using a set of precise coordinates and numbers.

3. Generate the G-code:
The STL file is then converted into a G-code file. G-code contains the exact instructions the 
3D printer follows to create the part layer by layer. Usually, the G-code is saved on a 
microSD card, which is then inserted into the 3D printer to start printing.

Only four STL files available on the Pedro Github repo (https://github.com/almtzr/Pedro) allow to 
print entirely the Pedro robot as described on the following image above: 

BASE.stl SERVO.stl

ARM.stl GEAR.stl

5 / 19
Pedro STEM Lesson n°1                                                                                                                   https://pedrobot.com

CAD STL G-CODE

https://pedrobot.com/
https://github.com/almtzr/Pedro


3. Design

3.1 The Pedro Anatomy

As robotic arm Pedro is equipped with four servomotors, each serving a distinct purpose in its 
movement. Three servomotors control the movement axes, while the fourth servomotor is dedicated to 
the gripper. 

 The first servomotor controls the base 
rotation, facilitating horizontal movement 
translation.

 The second servomotor manages the 
shoulder, enabling vertical rotation.

 The third servomotor operates the elbow, 
facilitating pick-up movements. 

 Finally, the fourth servomotor controls the 
gripper, enabling Pedro to grasp objects 
securely.

Together, these servomotors enable Pedro to perform 
a wide range of precise and coordinated movements, making it an effective tool for various robotic 
applications.
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3.2 Planetary Gear System

Pedro features three planetary motion modules, fully 3D-printed. These modules enable smooth and 
precise movements, powered by a continuous servomotor motor placed at the center of each joint.

3.3 What is a planetary gear system in robotics?

A planetary gearbox is a gear mechanism that optimizes motion transmission by reducing speed and 
increasing torque. It consists of:

 The sun gear: the central gear (driven by the motor)⚙️
 The planet gears: three gears rotating around the sun⚙️
 The ring gear (here replaced by Pedro’s structure), holding everything together⚙️

3.4 Why use a planetary system on Pedro?

 Increased power and precision✅
 Compact and robust design✅
 Fully 3D-printable with no complex parts✅

This system allows Pedro to execute smooth and precise movements in its three main joints: the base, 
shoulder, and elbow. No screws, no glue just 100% 3D printed.

7 / 19
Pedro STEM Lesson n°1                                                                                                                   https://pedrobot.com

https://pedrobot.com/


4. The Pedro Board

The Pedro Board is the brain of the robot. It is an Arduino-compatible microcontroller board 
(ATmega32u4) specially designed for the Pedro robot. It connects and controls all of Pedro’s parts 
from the motors to the sensors and communication modules.

4.1 Main Features

 Arduino Micro compatible – easy to program with the Arduino IDE
 4 servo motor outputs – control the arm, base, and gripper
 Integrated OLED screen (128×64) – displays mode, messages, and feedback in real time
 Wireless communication ports for:

 nRF24L01 (radio control)
 HC-05 (Bluetooth connection)
 ESP8266-01 (WiFi / IoT mode)

 Micro USB port – for programming and USB Serial mode
 Built-in battery charger – for a 7.4V Li-ion or LiPo battery
 Serial RX/TX pins – for external module or debugging

4.2 STEM Insight

The Pedro Board introduces students to embedded systems, where hardware and software work 
together to make intelligent machines. It’s a perfect platform to learn electronics, communication 
protocols, and real-world engineering design.
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4.3 Identify Each Element of the Pedro Board:

Students can analyze and label:

 Programmable components (buttons, LEDs, servo pins)
 Power and battery indicators
 Communication module ports (Radio, Bluetooth, WiFi)
 USB and serial connections

This activity helps them recognize how each part contributes to robot operation.

 PART 1 : Identification of Non-Programmable Elements

        Button ON/OFF         LED ON/OFF         LED CR1         LED OK2

        3x LEDs Battery3         Reset Button         Switch radio→bluetooth → wifi         Switch Command AT Bluetooth

1. LED CR : Indicates that the battery is currently charging.
2. LED OK : Indicates that the battery is fully charged.
3. Battery Level LEDs: Show the battery charge level from bottom to top (25%, 50%, and 100%).
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  PART 2 : Identification of Programmable1 Elements

        LED Base D13         LED Shoulder D11         LED Elbow D8         LED Gripper D7

        Pin Servo Base D5         Pin Servo Shoulder D6         Pin Servo Elbow D9         Pin Servo Gripper D10

        Button A0 Select Servo          Button A1 Rotation Servo          Button A2 Rotation Servo          Microcontroller (the brain)

1. A programmable element is a component on the electronic board that can be controlled by programming the 
microcontroller. This can include buttons, LEDs, or input/output pins.
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 PART 3 : Identification of Connectors

         Module Radio          Module WiFi          Module Bluetooth          OLED Screen 128x64

         7.4 V Battery Connector          Pin RX TX A4 A4 A51          Port micro USB2          Pin Bootloader3

The pins RX, TX, A3, A4, and A5 allow Pedro to communicate with external devices, such as an 
Arduino board, another Pedro robot, or components on a breadboard (e.g., a button or an LED). 
The USB port has three main functions:

1. Programming the board
2. Charging the battery
3. Controlling the Pedro robot via a graphical interface
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5. Installing and Uploading Pedro Firmware

1. Download and install the latest version of the Arduino IDE. 
2. Install the required libraries from the Library Manager: 

 PedroRobot: Tools → Manage Libraries → search PedroRobot → Install 

 U8glib: Tools → Manage Libraries → search U8glib → Install 

 RF24: Tools → Manage Libraries → search RF24 → Install 

3. Insert the Oled Screen into the Pedro board and Connect the board to your computer via USB. 
4. Select the correct port: 

 Tools → Select the port that appear when you connect Pedro robot 
5. Select the board type: 

 Tools → Board → Arduino Micro 
6. Open the example sketch: 

 File → Examples → PedroRobot → Pedro 
7. Compile and upload the sketch to your Pedro board. 

 ✅ If everything is correct, Pedro’s OLED screen will display “MANUAL MODE”.

8. Press the button A0 and observe what happen.
The LED corresponding to the selected servo light on. That button allows you to control each 
part of the robot. Here is the mapping between the LED ID and the servo ID

LED D13 → servo D5 (Base)
LED D11 → servo D6 (Shoulder)
LED D8  → servo D9 (Elbow)
LED D7  → servo D10 (Gripper)

Programming and embedded systems concepts will be covered in   Lesson 2  , where you’ll learn how the   
board operates and interacts with coding instructions.
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6.  Assembling

 💡 Pedro is entirely screw-free — all parts snap together easily!

Step 1: The Base

Attach the first servo to the base structure. This servo controls the horizontal rotation.
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Step 2: The Gripper

Assemble the gripper with the fourth servo. Ensure it opens and closes smoothly.
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Step 3: The Arm

Connect the shoulder and elbow servos. Check each movement before final assembly.
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7. Quiz (30 Questions)

1. What does the acronym P.E.D.R.O. stand for?
A) Programmable Electric Device for Robotic Operation
B) Programmable Educational Robot
C) Printed Electronic Design Robotic Object
D) Personal Educational Digital Robot

 Answer:✅

2. What is the main goal of the Pedro Lesson 1?
A) Build a drone
B) Discover the Pedro robot and understand its operation
C) Learn 3D modeling only
D) Program a mobile app

 ✅ Answer: 

3. What type of microcontroller powers Pedro?
A) ATmega32U4
B) ESP32
C) Raspberry Pi
D) STM32

 ✅ Answer: 

4. What software is required to program Pedro?
A) Visual Studio
B) Arduino IDE
C) Python
D) MATLAB

 ✅ Answer: 

5. What kind of motor does Pedro use?
A) Stepper motors
B) Brushed DC motors
C) Continuous rotation servomotors (360°)
D) Hydraulic actuators

 ✅ Answer:

6. How many servomotors are used in Pedro?
A) 2
B) 3
C) 4
D) 5

 ✅ Answer:

7. What is the purpose of the first servomotor?
A) Controls the gripper
B) Controls the base rotation for horizontal movement
C) Controls the shoulder
D) Controls the elbow

 ✅ Answer:

8. What does the fourth servomotor control?
A) The base
B) The shoulder
C) The elbow
D) The gripper

 ✅ Answer: 
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9. What material is used to print Pedro’s parts?
A) Aluminum
B) PLA or ABS plastic
C) Steel
D) Nylon

 ✅ Answer: 

10. What makes Pedro unique in its construction?
A) It is 100% 3D printed with no screws
B) It uses wooden parts
C) It is laser-cut
D) It is glued together

 ✅ Answer: 

11. What tool is used to generate 3D printer instructions from a design file?
A) STL file
B) G-code
C) CAD model
D) Firmware

 ✅ Answer: 

12. What is the first step in 3D printing a part?
A) Generate G-code
B) Export to STL
C) Design in CAD
D) Print immediately

 ✅ Answer:

13. What type of bearing system does Pedro use?
A) Magnetic bearings
B) Ball bearings
C) Roller bearings
D) Gear bearings

 ✅ Answer: 

14. What is the function of the base bearing?
A) Controls the gripper
B) Stabilizes vertical motion
C) Ensures stable and precise rotation
D) Controls speed

 ✅ Answer: 

15. What is the purpose of the planetary gear system in Pedro?
A) To reduce torque and increase speed
B) To increase torque and improve precision
C) To provide electrical power
D) To connect sensors

 ✅ Answer: 

16. How many planetary motion modules does Pedro have?
A) 1
B) 2
C) 3
D) 4

 ✅ Answer:
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17. Which gear in the planetary system is driven by the motor?
A) The planet gear
B) The sun gear
C) The ring gear
D) The outer shell

 ✅ Answer: 

18. What component allows Pedro to communicate wirelessly over long distances?
A) NRF24L01 module
B) Wi-Fi router
C) GPS module
D) Ultrasonic sensor

 ✅ Answer: 

19. Which module enables Pedro to connect to Wi-Fi ?
A) HC-05 Bluetooth module
B) ESP8266-01 module
C) NRF24L01 module
D) GPS module

 ✅ Answer: B

20. What is the screen resolution of Pedro’s OLED display?
A) 64x64
B) 128x32
C) 128x64
D) 256x128

 ✅ Answer: 

21. Which component represents the “brain” of the Pedro board?
A) The OLED Display
B) The ATmega32u4 Microcontroller
C) The Battery Charger
D) The NRF24L01 Radio Module

 ✅ Answer: 

22. What type of display is integrated into the Pedro Board?
A) LCD 16x2
B) OLED 128x64
C) TFT 2.4"
D) LED matrix

 ✅ Answer: 

23. What function does the Micro USB port serve?
A) Power only
B) Programming, charging, and serial control
C) Bluetooth pairing
D) WiFi connection

 ✅ Answer: 

24. Which module provides WiFi capability?
A) NRF24L01
B) HC-05
C) ESP8266-01
D) GPS module

 ✅ Answer:
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25. What does the ATmega32u4 allow students to do?
A) Design 3D parts
B) Program the robot using Arduino IDE
C) Print STL files
D) Connect motors directly

 ✅ Answer: 

26. Which component shows the battery charge level?
A) LED CR
B) LED OK
C) Battery Level LEDs
D) OLED screen

 ✅ Answer: 

27. What does the LED “CR” indicate?
A) Bluetooth connected
B) Battery charging
C) Low voltage
D) Power OFF

 ✅ Answer: 

28. What switch is used to select between NRF, BT, and WiFi?
A) Power switch
B) Communication switch
C) Mode button
D) Servo selector

 ✅ Answer: 

29. What is the purpose of the RX/TX pins?
A) Power the LEDs
B) Enable serial communication
C) Control servos
D) Connect battery

 ✅ Answer: 

30. What kind of system is the Pedro Board a good example of?
A) Mechanical system
B) Embedded system
C) Hydraulic system
D) Optical system

 ✅ Answer:

END
Pedro STEM Lesson n°1
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